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Abstract 

Sample text inserted for illustration. Replace with abstract text. Your abstract should give 
readers a summary of your article. It should concisely describe the contents of your article and 
include key terms. It should be informative, accessible and not only indicate the general scope 
of the article but also state the main results obtained and conclusions drawn. The abstract should 
be complete in itself; it should not contain undefined abbreviations and no table numbers, figure 
numbers, references or equations should be referred to. It should be suitable for direct inclusion 
in abstracting services and should not normally be more than 300 words. 
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I. INTRODUCTION 

HIS document is a template for Microsoft Word versions 
6.0 or later. If you are reading a paper or PDF version of 

this document, please download the electronic file,  
physics_access.docx, from the Physics Access Web site at 
physics_access_template_download_page so you can use it to 
prepare your manuscript.  

II. GUIDELINES FOR MANUSCRIPT PREPARATION 

When you open physics_access.docx, select “Page Layout” 
from the “View” menu in the menu bar (View | Page Layout), 
(these instructions assume MS 6.0. Some versions may have 
alternate ways to access the same functionalities noted here). 
Then, type over sections of physics_access.docx or cut and 
paste from another document and use markup styles. The pull-
down style menu is at the left of the Formatting Toolbar at the 
top of your Word window (for example, the style at this point 
in the document is “Text”). Highlight a section that you want 
to designate with a certain style, and then select the 
appropriate name on the style menu. The style will adjust your 
fonts and line spacing. Do not change the font sizes or line 
spacing to squeeze more text into a limited number of pages. 
Use italics for emphasis; do not underline.  

To insert images in Word, position the cursor at the 

insertion point and either use Insert | Picture | From File or 
copy the image to the Windows clipboard and then Edit | Paste 
Special | Picture (with “float over text” unchecked).  

Physics Access will do the final formatting of your paper.  

A. Author Affiliation Guidelines 

Physics Access welcomes submissions from both 
institutionally affiliated and independent researchers. While 
listing an institutional affiliation is encouraged when 
applicable, authors who are unaffiliated may indicate 
“Independent Researcher” in the affiliation section of their 
manuscript and submission profile. 
All submissions to Physics Access are evaluated solely based 
on scholarly merit, originality, and relevance to the field of 
physics. Authors are expected to uphold the highest standards 
of academic integrity and ethics, including the disclosure of 
any conflicts of interest and, where applicable, confirmation 
of ethical approval for research involving human or animal 
subjects.. 

B. Abbreviations and Acronyms 

Define abbreviations and acronyms the first time they are used 
in the text, even after they have already been defined in the 
abstract. Abbreviations such as NIP, IEEE, SI, ac, and dc do 
not have to be defined. Abbreviations that incorporate periods 
should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” 

T
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Do not use abbreviations in the title unless they are 
unavoidable (for example, “NIP” in the title of this article). Do 
not use abbreviations in the text except for units of measure. 
Always abbreviate these when using them with data (5 m; 30 
s). Except for temperature units (F, C, K) never abbreviate 
units of measure when using them in a non-data context (e.g., 
"we measured length in millimeters"; "time was recorded in 
minutes"; "temperature was measured in F (or C)"; "100 years 
have passed since Mendel did..."). The abbreviation for 
“seconds” is “s,” not “sec.” 

 

C. Other Recommendations 

Use one space after periods and colons. Hyphenate complex 
modifiers: “zero-field-cooled magnetization.” Avoid dangling 
participles, such as, “Using (1), the potential was calculated.” 
[It is not clear who or what used (1).] Write instead, “The 
potential was calculated by using (1),” or “Using (1), we 
calculated the potential.” 

Use a zero before decimal points: “0.85,” not “.85.” Use 
“cm3,” not “cc.” Indicate sample dimensions as “0.2 cm  0.3 
cm,” not “0.2  0.3 cm2.” Use “Wb/m2”, “Wb·m-2” or “webers 
per square meter,” not “webers/m2”. When expressing a range 
of values, write “6 to 8” or “6-9,” not “6~8”. 

A parenthetical statement at the end of a sentence is 
punctuated outside of the closing parenthesis (like this). (A 
parenthetical sentence is punctuated within the parentheses.) 
In American English, periods and commas are within 
quotation marks, like “this period.” Other punctuation is 
“outside”! Avoid contractions; for example, write “do not” 
instead of “don’t.” The serial comma is preferred: “A, B, and 
C” instead of “A, B and C.” 

Use Past Tense. Research papers reflect work that has been 
completed, therefore use the past tense throughout your paper 
(including the Introduction) when referring to the actual work 
that you did, including statements about your expectations or 
hypotheses. Use the past tense, as well, when referring to the 
work of others that you may cite. 

If you wish, you may write in the first person singular or 
plural and use the active voice (“I or we observed that ...” 
instead of “It was observed that ...”). Remember to check 
spelling. If your native language is not English, please get a 
native English-speaking colleague to carefully proofread your 
paper. 

III. MATH 

If you are using Word, use either the Microsoft Equation 
Editor or the MathType add-on (http://www.mathtype.com) 
for equations in your paper (Insert | Object | Create New | 
Microsoft Equation or MathType Equation). “Float over text” 
should not be selected.  

A. Equations 

Number equations consecutively with equation numbers in 
parentheses flush with the right margin, as in (1). First use the 
equation editor to create the equation. Then select the 

“Equation” markup style. Press the tab key and write the 
equation number in parentheses. To make your equations 
more compact, you may use the solidus ( / ), the exp function, 
or appropriate exponents. Use parentheses to avoid 
ambiguities in denominators. Punctuate equations when they 
are part of a sentence, as in 

 
 (1) 
 

Be sure that the symbols in your equation have been defined 
before the equation appears or immediately following. 
Italicize symbols (T might refer to temperature, but T is the 
unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” 
except at the beginning of a sentence: “Equation (1) is ... .” 

IV. UNITS 

Use either SI (MKS) or CGS as primary units. (SI units are 
strongly encouraged.) English units may be used as secondary 
units (in parentheses). This applies to papers in data storage. 
For example, write “15 Gb/cm2 (100 Gb/in2).” An exception 
is when English units are used as identifiers in trade, such as 
“3½-in disk drive.” Avoid combining SI and CGS units, such 
as current in amperes and magnetic field in oersteds. This 
often leads to confusion because equations do not balance 
dimensionally. If you must use mixed units, clearly state the 
units for each quantity in an equation. 

The SI unit for magnetic field strength H is A/m. However, 
if you wish to use units of T, either refers to magnetic flux 
density B or magnetic field strength symbolized as µ0H. Use 
the center dot to separate compound units, e.g., “A·m-2.” 

V. SOME COMMON MISTAKES 

The word “data” is plural, not singular. The subscript for 
the permeability of vacuum µ0 is zero (0), not a lowercase 
letter oh (o). The term for residual magnetization is 
“remanence”; the adjective is “remanent”; do not write 
“remnance” or “remnant.” Use the word “micrometer” instead 
of “micron.” A graph within a graph is an “inset,” not an 
“insert.” The word “alternatively” is preferred to the word 
“alternately” (unless you really mean something that 
alternates). Use the word “whereas” instead of “while” (unless 
you are referring to simultaneous events). Do not use the word 
“essentially” to mean “approximately” or “effectively.” Do 
not use the word “issue” as a euphemism for “problem.” When 
compositions are not specified, separate chemical symbols by 
en-dashes; for example, “NiMn” indicates the intermetallic 
compound Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of 
some composition NixMn1-x. 

Be aware of the different meanings of the homophones 
“affect” (usually a verb) and “effect” (usually a noun), 
“complement” and “compliment,” “discreet” and “discrete,” 
“principal” (e.g., “principal investigator”) and “principle” 
(e.g., “principle of measurement”). Do not confuse “imply” 
and “infer.”  
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Prefixes such as “non,” “sub,” “micro,” “multi,” and “ultra” 
are not independent words; they should be joined to the words 
they modify, usually without a hyphen. There is no period 
after the “et” in the Latin abbreviation “et al.” (it is also 
italicized). The abbreviation “i.e.,” means “that is,” and the 
abbreviation “e.g.,” means “for example” (these abbreviations 
are not italicized). 

Guidelines for Graphics Preparation 
and Submission 

A. Types of Graphics 

The following list outlines the different types of graphics 
published in Physics Access. They are categorized based on 
their construction, and use of color / shades of gray: 

1) Color/Grayscale figures 
Figures that are meant to appear in color, or shades of 
black/gray. Such figures may include photographs,  
illustrations, multicolor graphs, and flowcharts. 

2) Line Art figures 
Figures that are composed of only black lines and shapes. 
These figures should have no shades or half-tones of gray, 
only black and white. 

3) Tables 
Data charts which are typically black and white, but 
sometimes include color. 

B. Multipart figures 

Figures compiled of more than one sub-figure presented 
side-by-side, or stacked. If a multipart figure is made up of 
multiple figure types (one part is lineart, and another is 
grayscale or color) the figure should meet the stricter 
guidelines. 

C. File Formats for Graphics 

Format and save your graphics using a suitable graphics 
processing program that will allow you to create the images as 
PostScript (PS), Encapsulated PostScript (.EPS), Tagged 
Image File Format (.TIFF), Portable Document Format 
(.PDF), or Portable Network Graphics (.PNG) sizes them, and 
adjusts the resolution settings.  

TABLE I UNITS FOR MAGNETIC PROPERTIES 

Symbol 
Quantity 

Conversion from Gaussian and 

CGS EMU to SI a 

 magnetic flux 1 Mx  108 Wb = 108 V·s 

B magnetic flux density,  

  magnetic induction 

1 G  104 T = 104 Wb/m2 

H magnetic field 
strength 

1 Oe  103/(4) A/m 

m magnetic moment 1 erg/G = 1 emu  

 103 A·m2 = 103 J/T 

M magnetization 1 erg/(G·cm3) = 1 emu/cm3 

 103 A/m 

4M magnetization 1 G  103/(4) A/m 

 specific magnetization 1 erg/(G·g) = 1 emu/g  1 A·m2/kg 

j magnetic dipole  

  moment 

1 erg/G = 1 emu  

 4 1010 Wb·m 

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3 

 4 104 T 

, susceptibility 1  4 

 mass susceptibility 1 cm3/g  4 103 m3/kg 

 permeability 1  4 107 H/m  

  = 4 107 Wb/(A·m) 

r relative permeability r 

w, W energy density 1 erg/cm3 101 J/m3 

N, D demagnetizing factor 1  1/(4) 

Vertical lines are optional in tables. Statements that serve as captions for 
the entire table do not need footnote letters.  

aGaussian units are the same as cg emu for magnetostatics; Mx = maxwell, 
G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T = tesla, m = 
meter, A = ampere, J = joule, kg = kilogram, H = henry. 

 

 

Fig. 1.  Magnetization as a function of applied field. Note that “Fig.” is 
abbreviated. There is a period after the figure number, followed by two spaces. 
It is good practice to explain the significance of the figure in the caption. 
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D. Resolution 

The proper resolution of your figures will depend on the type 
of figure. Author photographs, color, and grayscale figures 
should be at least 300dpi. Lineart, including tables should be 
a minimum of 600dpi. 

E. Color Space 

The term color space refers to the entire sum of colors that 
can be represented within the said medium. For our purposes, 
the three main color spaces are Grayscale, RGB 
(red/green/blue) and CMYK (cyan/magenta/yellow/black). 
RGB is generally used with on-screen graphics, whereas 
CMYK is used for printing purposes. 

All color figures should be generated in RGB or CMYK 
color space. Grayscale images should be submitted in 
Grayscale color space. Line art may be provided in grayscale 
OR bitmap color space. Note that “bitmap color space” and 
“bitmap file format” are not the same thing. When bitmap 
color space is selected, .TIF/.TIFF/.PNG are the 
recommended file formats. 

F. Accepted Fonts within Figures 

When preparing your graphics Physics Access suggests that 
you use of one of the following Open Type fonts: Times New 
Roman, Helvetica, Arial, Cambria, and Symbol. If you are 
supplying EPS, PS, or PDF files all fonts must be embedded. 
Some fonts may only be native to your operating system; 
without the fonts embedded, parts of the graphic may be 
distorted or missing. 

Safe options when finalizing your figures is to strip out the 
fonts before you save the files, creating “outline” type. This 
converts fonts to artwork what will appear uniformly on any 
screen. 

G. Using Labels within Figures 

1) Figure Axis labels  
Figure axis labels are often a source of confusion. Use words 

rather than symbols. As an example, write the quantity 
“Magnetization,” or “Magnetization M,” not just “M.” Put 
units in parentheses. Do not label axes only with units. As in 
Fig. 1, for example, write “Magnetization (A/m)” or 
“Magnetization (A m1),” not just “A/m.” Do not label axes 
with a ratio of quantities and units. For example, write 
“Temperature (K),” not “Temperature/K.”  

Multipliers can be especially confusing. Write 
“Magnetization (kA/m)” or “Magnetization (103 A/m).” Do 
not write “Magnetization (A/m)  1000” because the reader 
would not know whether the top axis label in Fig. 1 meant 
16000 A/m or 0.016 A/m. Figure labels should be legible, 
approximately 8 to 10 point type. 

 

2) Subfigure Labels in Multipart Figures and Tables 
Multipart figures should be combined and labeled before 

final submission. Labels should appear centered below each 
subfigure in 8 point Times New Roman font in the format of 
(a) (b) (c). Authors are encouraged to supply the original 
spreadsheet data used to produce the graph to enable us 
maintain a uniform look for all graphs in the journal. 

 

H. Referencing a Figure or Table within Your Paper 

When referencing your figures and tables within your paper, 
use the abbreviation “Fig.” even at the beginning of a 
sentence. Do not abbreviate “Table.” Tables should be 
numbered with Roman Numerals. 

 

I. Submitting Your Graphics 

Because Physics Access will do the final formatting of your 
paper, you do not need to position figures and tables at the top 
and bottom of each column. In fact, all figures, figure captions, 
and tables can be placed at the end of your paper. Place figure 
captions below the figures; place table titles above the tables. 
Please do not include captions as part of the figures, or put 
them in “text boxes” linked to the figures. Also, do not place 
borders around the outside of your figures. 

 

J. Color Processing / Printing in Physics Access 

Physics Access allows an author to publish certain color 
figures on at no charge, and automatically convert them to 
grayscale for print versions. Additional figures and tables may 
alternatively be printed in color if an author chooses to do so. 
Please note that this service comes at an extra expense to the 
author. If you intend to have print color graphics, include a 
note with your final paper indicating which figures or tables 
you would like to be handled that way, and stating that you are 
willing to pay the additional fee, as additional fee may be 
required. 

 

VI. CONCLUSION 

A conclusion section is required. Although a conclusion may 
review the main points of the paper, do not replicate the 
abstract as the conclusion. A conclusion might elaborate on 
the importance of the work or suggest applications and 
extensions.  

APPENDIX 

Appendixes, if needed, appear before the acknowledgment. 
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ACKNOWLEDGMENT 

The preferred spelling of the word “acknowledgment” in 
American English is without an “e” after the “g.” Use the 
singular heading even if you have many acknowledgments. 
Avoid expressions such as “One of us (S.B.A.) would like to 
thank ... .” Instead, write “F. A. Author thanks ... .”  

REFERENCES, PLAGIARISM AND FOOTNOTES 

A. References 

 
References to the research findings of others are an integral 

component of any research paper. The usual practice is to 
summarize the finding or other information in your own words 
and then cite the source. Any ideas or other information that 
are not your own must be substantiated by a reference that is 
cited in the text. As a rule, in research papers, direct quotation 
and footnoting are not practiced - simply restate the author's 
ideas or findings in your own words and provide a citation. 

Reference need to be cited in text. Cited references should 
appear on the line, in square brackets, inside the punctuation.  
Multiple references are each numbered with separate brackets. 
When citing a section in a book, please give the relevant page 
numbers. In text, refer simply to the reference number. Do not 
use “Ref.” or “reference” except at the beginning of a 
sentence: “Reference [3] shows ... .” Please do not use 
automatic endnotes in Word, rather, type the reference list at 
the end of the paper using the “References” style. 

Reference numbers are set flush left and form a column of 
their own, hanging out beyond the body of the reference. The 
reference numbers are on the line, enclosed in square brackets. 
In all references, the given name of the author or editor is 
abbreviated to the initial only and precedes the last name. Use 
them all; use et al. only if names are not given. Use commas 
around Jr., Sr., and III in names. Abbreviate conference titles, 
provide the issue number, page range, volume number, year, 
and/or month if available. When referencing a patent, provide 
the day and the month of issue, or application. References may 
not include all information; please obtain and include relevant 
information. Do not combine references. There must be only 
one reference with each number. If there is a URL included 
with the print reference, it can be included at the end of the 
reference. 

Other than books, capitalize only the first word in a paper 
title, except for proper nouns and element symbols. For papers 
published in translation journals, please give the English 
citation first, followed by the original foreign-language 
citation See the end of this document for formats and examples 
of common references. 

 
1It is recommended that footnotes be avoided (except for the unnumbered 

footnote with the receipt date on the first page). Instead, try to integrate the 
footnote information into the text. 

B. Plagiarism 

Plagiarism (use of others words, ideas, images, etc. without 
citation) is not to be tolerated and can be easily avoided by 
adequately referencing any and all information you use from 
other sources. In the strictest sense, plagiarism is 
representation of the work of others as being your work. 
Paraphrasing other's words too closely may be construed as 
plagiarism in some circumstances. There is virtually no 
circumstance in which the findings of someone else cannot be 
expressed in your own words with a proper citation of the 
source.  

C. Footnotes 

Number footnotes separately in superscripts (Insert | 
Footnote).1 Place the actual footnote at the bottom of the 
column in which it is cited; do not put footnotes in the 
reference list (endnotes). Use letters for table footnotes (see 
Table I).  

VII.  

VIII. SUBMITTING YOUR PAPER FOR REVIEW 

A. Review Stage Using Word 6.0 or Higher 

If you want to submit your file with one column 
electronically, please do the following: 

 --First, click on the View menu and choose Print 
Layout. 

 --Second, place your cursor in the first paragraph. Go 
to the Format menu, choose Columns, choose one column 
Layout, and choose “apply to whole document” from the 
dropdown menu. 

 --Third, click and drag the right margin bar to just 
over 4 inches in width. 

The graphics will stay in the “second” column, but you can 
drag them to the first column. Make the graphic wider to push 
out any text that may try to fill in next to the graphic. 

B. Peer Review Policy 

Physics Access employs a rigorous peer review system. All 
submitted manuscripts undergo a double-blind peer review 
process before publication. 

C. Final Stage Using Word 6.0 

When you submit your final version (after your paper has 
been accepted), print it in two-column format, including 
figures and tables. You must also send your final manuscript 
through a Web manuscript submission system. You may use 
Zip for large files, or compress files using Compress, Pkzip, 
Stuffit, or Gzip. 

D. Copyright Form 

Authors must submit an Electronic Physics Access 
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Copyright Form (EPACF) upon submitting their final 
manuscript files.  You can access the EPACF system through 
your manuscript submission system. You are responsible for 
obtaining any necessary approvals and/or security clearances. 
 

IX. DOP_KASU PUBLISHING POLICY 

Physics Access policy requires that authors should only 
submit original work that has neither appeared elsewhere for 
publication, nor is under review for another refereed 
publication. The submitting author must disclose all prior 
publication(s) and current submissions when submitting a 
manuscript. Do not publish “preliminary” data or results. The 
submitting author is responsible for obtaining agreements of 
all coauthors and any consent required from employers or 
sponsors before submitting an article. Physics Access strongly 
discourages courtesy authorship; it is the obligation of the 
authors to cite only relevant prior work. 

. 

X. PUBLICATION PRINCIPLES 

The two types of contents of that are published are 1) peer-
reviewed and 2) archival. Physics Access publishes scholarly 
articles of archival value as well as tutorial expositions and 
critical reviews of classical subjects and topics of current 
interest.  

Authors should consider the following points: 
1) Technical papers submitted for publication must advance 

the state of knowledge and must cite relevant prior work.  
2) The length of a submitted paper should be commensurate 

with the importance, or appropriate to the complexity, of 
the work. For example, an obvious extension of 
previously published work might not be appropriate for 
publication or might be adequately treated in just a few 
pages. 

3) Authors must convince both peer reviewers and the 
editors of the scientific and technical merit of a paper; the 
standards of proof are higher when extraordinary or 
unexpected results are reported.  

4) Because replication is required for scientific progress, 
papers submitted for publication must provide sufficient 
information to allow readers to perform similar 
experiments or calculations and use the reported results. 
Although not everything need be disclosed, a paper must 
contain new, useable, and fully described information. 
For example, a specimen’s chemical composition need 
not be reported if the main purpose of a paper is to 
introduce a new measurement technique. Authors should 
expect to be challenged by reviewers if the results are not 
supported by adequate data and critical details. 

5) Papers that describe ongoing work or announce the latest 
technical achievement, which are suitable for 
presentation at a professional conference, may not be 
appropriate for publication. 

References 

The reference format is strictly IEEE format. See Basic IEEE 
reference format in the sections that follow. 

Format for books: 

J. K. Author, “Title of chapter in the book,” in Title of His Published Book, 
xth ed. City of Publisher, (only U.S. State), Country: Abbrev. of Publisher, 
year, ch. x, sec. x, pp. xxx–xxx. 

Examples: 

[1] G. O. Young, “Synthetic structure of industrial plastics” in 
Plastics, 2nd ed., vol. 3, J . Peters, E d . New Y o r k , NY, 
USA: McGraw-Hill,1964, pp.15–64. 

[2] W. -K. Chen, Linear Networks and Systems. Belmont, 
CA, USA: Wadsworth, 1993, pp. 123–135. 

 

Basic format for periodicals: 

J.  K. Author, “Name of paper,”  Abbrev.  Title  of  Periodical, vol. x,   no. x, 
pp. xxx-xxx, Abbrev. Month, year, DOI. 10.1109.XXX.123456. 

Examples: 

[3] J. U. Duncombe, “Infrared navigation—Part I: An 
assessment of feasibility,” IEEE Trans. Electron Devices, 
vol. ED-11, no. 1, pp. 34–39, Jan. 
1959,10.1109/TED.2016.2628402. 

[4] E. P. Wigner, “Theory of traveling-wave optical laser,” 
Phys. Rev.,  
vol. 134, pp. A635–A646, Dec. 1965. 

[5] E. H. Miller, “A note on reflector arrays,” IEEE Trans. 
Antennas Propagat., to be published. 

 

Basic format for reports: 

J. K. Author, “Title of report,” Abbrev. Name of Co., City of Co., Abbrev. 
State, Country, Rep. xxx, year. 

Examples: 

[6] E. E. Reber, R. L. Michell, and C. J. Carter, “Oxygen 
absorption in the earth’s atmosphere,” Aerospace Corp., 
Los Angeles, CA, USA, Tech. Rep. TR-0200 (4230-46)-3, 
Nov. 1988. 

[7] J. H. Davis and J. R. Cogdell, “Calibration program for the 
16-foot antenna,” Elect. Eng. Res. Lab., Univ. Texas, 
Austin, TX, USA, Tech. Memo. NGL-006-69-3, Nov. 15, 
1987. 

 

Basic format for handbooks: 

Name of Manual/Handbook, x ed., Abbrev. Name of Co., City of Co., 
Abbrev. State, Country, year, pp. xxx-xxx. 

Examples: 

[8] Transmission Systems for Communications, 3rd ed., 
Western Electric Co., Winston-Salem, NC, USA, 1985, pp. 
44–60. 

[9] Motorola Semiconductor Data Manual, Motorola 
Semiconductor Products Inc., Phoenix, AZ, USA, 1989. 
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Basic format for books (when available online): 

J. K. Author, “Title of chapter in the book,” in Title of Published Book, xth 
ed. City of Publisher, State, Country: Abbrev. of Publisher, year, ch. x, sec. x, 
pp. xxx–xxx. [Online]. Available: http://www.web.com  

Examples: 

[10] G. O. Young, “Synthetic structure of industrial plastics,” in 
Plastics, vol. 3, Polymers of Hexadromicon, J. Peters, Ed., 
2nd ed. New York, NY, USA: McGraw-Hill, 1964, pp. 15-
64. [Online]. Available: http://www.bookref.com.  

[11] The Founders’ Constitution, Philip B. Kurland and Ralph 
Lerner, eds., Chicago, IL, USA: Univ. Chicago Press, 1987. 
[Online]. Available: http://press-
pubs.uchicago.edu/founders/ 

[12] The Terahertz Wave eBook. ZOmega Terahertz Corp., 
2014. [Online]. Available: http://dl.z-
thz.com/eBook/zomega_ebook_pdf_1206_sr.pdf. 
Accessed on: May 19, 2014.  

[13] Philip B. Kurland and Ralph Lerner, eds., The Founders’ 
Constitution. Chicago, IL, USA: Univ. of Chicago Press, 
1987, Accessed on: Feb. 28, 2010, [Online] Available: 
http://press-pubs.uchicago.edu/founders/  

 

Basic format for journals (when available online): 
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